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Objectives —Microsoft Excel

* Understand the use of spreadsheets and Excel
* Learn the parts of the Excel window

* Scroll through a worksheet and navigate
between worksheets

 Create and save a workbook file

* Enter text, numbers, and dates into a
worksheet

e Resize, insert, and remove columns and rows
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Objectives

e Select and move cell ranges

* |Insert formulas and functions

* |Insert, delete, move, and rename worksheets
* Work with editing tools

* Preview and print a workbook
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isual Overview

Excel stores spreadshests in B
files called workbooks. The
contents of a workbook are
shownina workbookwindow. | = _ ookl -
n Home Insart Fape Layout Formulas Data Reyisw Visw
T & & 2 s -
‘ j Calibri it r A A | = == =Y Genen
| Ba - S
Pnfth B 7 U~ i~ {»‘A' E== = [Bd> | §ov
Ckpboard = [l Font ™ Alignment [
The Name box displays the T uk T :
[cdl reference of ﬁnp:ryﬁvo cell. [T K17 o,
II_>' d| A | B E F
™ |- 1 1
" The Select Al button is ?
used to select all of the cells |
in the active workshest. 3| The formula bar
\ J it displays the value
a or formula entered
| in the active cell.
3
( The row headings are the 6
numbers along the left side |
of the worksheet wind ow 7
that identify the different |
rows in the worksheet. You 2
click a row heading to select |
L the entire worksheet row. ) 9 |
| 10 ‘
11 |
12 |
13
14|
15
16
17 :
A workbook is made up of
18 individual sheets. Each sheet is
- | identified by a sheet name,
The sheet tab scrolling \ et :
Htore kol bR b o 1,9, | which appears in the sheet tab.
sheet tabs in the worksheet. 20
21| —
M 4 ) M Sheetl ~Sheat? = Sheetd - %]
Re. Soal k
The sheet currently dilﬂmd) Bepdy | Sre TD( l The other sheets in the workbook
in the workbook window s ! are not visible. The sheet tabs for
active sheet; its Mﬁaiuwhite.J these inactive sheets are gray.
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The Excel Window

The column headings are

the letters along the top of

the worksheet window that
identify the different
columns in the worksheet.
You click aletter to select
the entire column.

6@ o R
LI
1 Y <z = : & |
o= . & 3 Delete ~ | [@ - Z
) “8 3% | Conditional Format  Cell o34 . Sori& Find&
% Formatting v as Tahla + Stylas v }”jfovmal Y| & Filter~ Select~
Number | Styfes Cells Edting
v
=
G Ho | s L | MZ
————
Each intersection of a row and
column is a cell. Worksheet data is
placed within separate cells,

A worksheet displays the
contents of the spreﬁshut
{aid out in a grid of rows and
columns.

The cell cumrently selected in the
active worksheet is the active ceil.
The active cell is outlined witha
thick border and the corresponding
row and column headings are
highlighted.

/

1

The Zoom controls increase or
decrease the display of content in
the worksheet. These tutorials show
the worksheet zoomed to 120%.

v

il
(#)

Il |
|[EEmE 120% (o))
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Introducing Microsoft Excel 2010

 Computer program used to enter, store, analyze,
and present quantitative data

* Creates electronic versions of spreadsheets

— Collection of text and numbers laid out in a grid
* Displays values calculated from data
* Allows what-if analysis

— Ability to change values in a spreadsheet and
assess the effect they have on calculated values
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Spreadsheet Data in Excel

" 2 4 E e el | 3=Meéa- - :
_Caten N ~A A Tl ® ZF | Genenal ’g u ’ ;‘mm. 3- %{ ‘ﬂ
g BT B T B A EESEE DS v W o et e |y | o e
{Clpooare 1 Fant Khgnment | Wurer G thder | ¢ femng
ALE - (= A v

[ 4] A ul n C o | B | F G LS
1 Cash Flow Comparison

7 Budgeted vs. Actual

3 Jan-13

4 Budgeted Actual

5 Cash balance (start of month) $4,500.00 54,500.00
_ 6 Cash receipts

7 | Cashsales 12,600.00 14,688.00

& Cash expenditures

9  Advertising 1,200.00 1,425.00 3
10 Woges 7,200.00 7,850,00

11 Supplies 3,600.00 §,350.00

17 Total cash expenditures 12,000.00 13,625.00

13 Net cash flow 600.00 1,063.00

14 Cash balance {end of month) £5,100.00 55,563.00
A5

16 | !

17

18

W e b 0| Cash Flow , AQUATED( EXDARILINS Cach Expanotures Ot & [Tel ) ] ]
Reaty | R B I v (+)
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Worksheet Navigation

A workbook can have two kinds of sheets:

—Worksheet contains a grid of rows and
columns into which user enters data

— Chart sheet provides visual representation
of data

* Cell reference identifies column/row location
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Worksheet Navigation

* To navigate between worksheets
— Use sheet tabs
* To navigate within a worksheet

—Use mouse, keyboard, GoTo dialog box, or

type cell reference in Name box
GoTo & ""T’-.‘—

Go to:

" cell reference for Reference:
the cell that you C14

want to make active l
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Worksheet Navigation Keys

Press To move the active cell

T .], = =) Up, down, left, or right one cell

Home To column A of the current row

Ctrl+Home To cell AT

Ctrl+End To the last cell in the worksheet that contains data
Enter Down one row or to the start of the next row of data
Shift+Enter Up one row

Tab One column to the right

Shift+Tab One column to the left

Page Up, Page Down
Ctrl+Page Up, Ctrl+Page Down

Up or down one screen

To the previous or next sheet in the workbook

New Perspectives on Microsoft Office 2010
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Planning a Workbook

e Use a planning analysis sheet to define:
— Goal or purpose of workbook
—Type of data to collect

—Formulas needed to apply to data you
collected and entered

— Appearance of workbook content

New Perspectives on Microsoft Office 2010
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Entering Text, Numbers, and Dates

* Text data
— Combination of letters, numbers, and symbols

— Often referred to as a text string

* Number data

— Numerical value to be used in a mathematical
calculation

e Date and time data

— Commonly recognized formats for date and time
values

New Perspectives on Microsoft Office 2010 12



Entering Text

* New data appears in both the active cell and
the formula bar

* Truncation

* AutoComplete feature

* To enter multiple lines of text within a cell
—Create a line break with Alt + Enter

New Perspectives on Microsoft Office 2010

13



Entering Text

Fili® L s bl
n Hone g nsert Pagtlryéu' ‘r-mull; Daty liew-w M . & o = qe'
= o - + w50 - i J i Swkwens X+ A
- Calion T c AN T e B | Genenl v ﬁ ﬁ !{ ;"Deme' &~ 2!( tﬂ
|I"™ @ B B B AL EE[FE M) $-% 0 WA e oy | Edtemat- | 2~ Anars ot
Lf.lt;b:nu n Fant . Abgomenm . l Norner T Sykes f Cels Fditing
- — ki
47T s C p | 'e | ¥ | s I | s S | < |

1 Rip(‘xty D%ital Customer Orders

2
3 Author  Amanda Dunn <—(your name appears hereJ
text that doesn't fit within a callJ

4 Date
| S Purpose Torecord orders from RipCity Digital customers —-& k covers the cell(s) to the l‘ight
6 .
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Entering Numbers

Rt Atow

Fomudyt Oty

:. Calin ‘il c AN === & & Goel - -"-_:" ﬁ _% ;.:”:-"e- ; 2{ lﬂ
# | PT U A EEEEE W % WA o | o A TS
Clgboard Fant Algnent 1 Hunber s | Cala Editing
a3 - 5 &£
) c D 3 F 6 | H I ) L =
hUMbeS are w 1 | Lost First Address  Date DVDs Price per DVD r numeric value
right-aligned wrEm formatted as
within the cell % currency
Merrill,
2 Dowes Gregory Mi48637 3/13/2013 7 129
3
=
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Working with Columns and Rows

* To make data easier to read:

— Modify size of columns and rows in a
worksheet

* To modify size of columns or rows:
—Drag border to resize
—Double-click border to autofit

—Format the Cells group to specify

New Perspectives on Microsoft Office 2010
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Working with Columns and Rows

* Column width

—Expressed in terms of number of characters
or pixels (8.43 characters equals 64 pixels)

— Note: Pixel size is based on screen
resolution

* Row height

—Measured in points (1/72 of an inch) or
pixels

— Default row height: 15 points or 20 pixels

New Perspectives on Microsoft Office 2010
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Working with Columns and Rows

Incer Pyge lgyout  Formulat

z‘ Caltori M AL == P o Genenl - :'% -_-a % 3::"::” ;. %‘f lﬂ
Ty BIU- S A EEEEE E|$-% 0 Wl Cnme tome o |0 O e e
Qeboatd 1 Funt . Alyniaen - Wy h Shyfe) Tels .Ei.‘L_"“

At | Last ' ' @
row heights match | 4 A 3 c I E | F G H I =
their contents 1 |Lost First Address Date DVDs Price per DVD

402 Elm St
2 Dawes Grepary Merrill, M1 48637 3/13/2013 7 $17.20
1025 Drake Ave
=) Gorcia Susarn Excter, NH 03833 3/14/2013 25 $15.79
5 North Ln
4 _Totbet Dr. Lilla Oswepgo, NY 13126 3/17/2013 32 $12.90
24 Mountain Dr.
\5 Rhoden Tony Aubum, ME 04210 3/24/2013 20 515,79
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Working with Columns and Rows

* Inserting a column or row

— Existing columns or rows shift to

accommodate

Page Lagout

Fomuly Oary

Fimn pans

To - o8

g BT O & EEEEE ) % o R e ot Tonke Syt « | B Famet+ | @ P~ Seie -
fpooard ant Avgnment Nareoer Stylet Fahng
T . L o —— ’ v
x 8 c | o 3 F G H %3
1 Llast First Address [ Phone Date DVDs Price per DVD [
402 Elm St
2 |Dawes Gregory Merrill, M1 48637 (089} 555-3433  3/13/2013 7 $17.29
(new column content } . et L0 -
J 3 Garcia Susan Excter, NH 03833 (603} 555-1091  3/14/2013 25 $15.79
S Novth Ln.
4 Torbet Dr. Lilla Oswego, NY 13126 | (315)555-7823  3/17/2013 32 $12.99
24 Mountain Dr,
5 Rhoden Tony Auburn, ME 04210 L (207} 555-9915 3/24/2013 20 515.79
o] — :
,‘, - - . _—
3
9 3 m—me
= ( inserted column existing columr)s
T shifted to the right
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Working with Columns and Rows

* Deleting and clearing a row or column

— Deleting removes both the data and the
cells

— Clearing removes the data, leaving blank
cells where data had been

New Perspectives on Microsoft Office 2010 20



Visual Overview

| Home | Insart

View

Page layout  Formulas  Data  Revisw
A
" The File tab opens Backstage | = ;& a e ] A K| = &' Curreny
view, which provides access Baste a2 a e ;
to commands for saving and T B L e M A EE B~ $-%
printing the workbook.
- ~ | Chipboard 7 | Font i | Alignment ] Numbe
The spelling check Y H10 - £ | =SUM(HE:H) }——r
e spelling checker
veriﬁ:ﬁ!ekvr‘ordsinthe 0 | A l B C D
active works! eet against the 3= RipCity Digital
EInarams dlctl,onary.tY:: | poty L The Page Layout tab A formula is an expression
an é“.’:?l" anignore lled 2 Customer Orders | provides commands to thatreturns a value, This
(etee ORI =5 [ change the way worksheets | | formula calculates the sum
3 | 3/31/2013 appear on printed pages. of the values in range H&:H9.
4 4
5 |Last First Address Phone
135 College Avenue
6 |Ferris Andrew Bar Harbor, ME 04609 (207) 555-
z T 1025 Dreke Avenue
range or range. Ranges | 7| Garcia Susan Exeter, NH 03833 (603) 555
::m:::',:"dm mer 5 North Lane
8 |Torbet Dr. Lila Oswego, NY 13126 (315) 555
24 Mountain Drive
9 |Rhaden Tony Auburn, ME 04210 (207) 555
a6y
11
13|
13
[ You can rename a The Insert Warksheet
14 sheet so that it hasa tab inserts a new
[ brief description of its worksheet at the end
2 15 | contents or purpose. of the workbook.
The status bar indicates 16
whether you are in Ready Do |
mode or gﬁt mode. 17 |
| i 4 ¢ ¥ Documentation | Customer Orders /%1
Ready | Average. 51

New Perspectives on Microsoft Office 2010
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Worksheet Data

- 9% ¢ | %8 ;% | Conditional Formet  Cell

Sensert X v
;uelltev @~ %r [ﬁ

Sert & Find &

( The Sum button (also
referred to as the AutoSum
feature) inserts Excel
functions to sum, average,
or count all the values in a
column or row, as well as
display the minimum or
maximum value in a column
_orrow.

Formatting ~ as Table » Styles~ \_éj Format ~ | (2 Fifter~ Select~ (“The Find command locates
Number s | Styfes Celis | Editing x&il%:aal:celst;:ts:plm
st d overwrites them,
— | Click the Find & Select
D E F ’ G H P button to access both
T L commands.
Phone Date DVDs Price per DVD Charge
(207) 555-0101 3/5/2013 2 $18.29 $36.58
p
( : A anadneent 7
603)555-1091  3/14/2013 25 $15.79  $394.75 = gpomuugg-s;; =
Eﬁngtan jular block of cells.
; s adjacentrange covers
(315)555-7823  3/17/2013 32 $1299 $415.68 | cells GRHI0.
[207)555-9915  3/24/2013 20 $15.79 $315.80
TOTAL 79 $1;162.81
|
A nonadjacent range is two or | | The view buttons
more distinct adjacent ranges. change how the B
This nonadjacent range covers worksheet content is
the adjacent range A6:A9, the displayed—Normal
adjacent range E&EID, and the | | view, Page Layout view,
adjacent range G6:H10. or Page Break Preview.
4] T ] » [

Average: §12,906.19  CountiiB  Sumy§157,78048 |@IQLLI 120% (=—LF—{¥)
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Working with Cells and Ranges

* Range reference indicates location and size of
a cell range

— Adjacent (A1:G5)

—Nonadjacent (A1:A5;F1:G5)
* Selecting a range

—Work with all cells in the range as a group
* Moving and copying a range

—Drag and drop

— Cut and paste

New Perspectives on Microsoft Office 2010
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Working with Cells and Ranges

* |nserting and deleting a range

— Existing cells shift to accommodate the
change

inserted in this I

'Lnew cellswill be |
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Working with Formulas

* Formula

— An expression that returns a value

— Written using operators that combine different
values, resulting in a single displayed value

Arithmetic
Operation Operator Example Description
Addition + =10+A1 Adds 10 to the value in cell Al
=B1+B2+B3 Adds the values in cells B1, B2, and B3
Subtraction - =C9-B2 Subtracts the value in cell B2 from the value in cell C9
=1-D2 Subtracts the value in cell D2 from 1
Multiplication * =Co*B9 Multiplies the values in cells C% and B9
=E5*0.06 Multiplies the value in cell ES by 0.06
Division / =C9/B9 Divides the value in cell C9 by the value in cell B9
=D15/12 Divides the value in cell D15 by 12
Exponentiation A =B5"3 Raises the value of cell BS to the third power
—3AB5 Raises 3 to the value in cell BS

New Perspectives on Microsoft Office 2010
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Working with Formulas

* Entering a formula

— Click cell where you want formula results to
appear

—Type = and an expression that calculates a
value using cell references and arithmetic
operators

* Cell references allow you to change
values used in the calculation without
having to modify the formula itself

—Press Enter or Tab to complete the formula

New Perspectives on Microsoft Office 2010
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Working with Formulas

* Order of precedence

—Set of predefined rules used to determine
sequence in which operators are applied in
a calculation

Formula Application of the Order of Precedence Result
=50+10*5 10*5 calculated first and then 50 is added 100
=(50+10)*5 (50+10) calculated first and then multiplied by 5 300
=50/10-5 50/10 calculated first and then 5 is subtracted 0
=50/{10-5) (10-5) calculated first and then 50 is divided by that value 10
=50/10*5 Two operators at same precedence level, so the calculation is done 25
left to right in the expression
=50/(10*5) (10*5) calculated first and then 50 is divided by that value 1
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Working with Formulas

* Viewing a formula

— Select cell and review expression displayed in the

formula bar

— Each cell reference is color coded in the formula
and corresponding cell in the worksheet

EFFECT R AT ~
A B 0 0 £ formula in cell Hé
~ : w 1 |RipCity Digital cell border colors match the | multiplies the values
formula displayed 2 Customer Orders colors in the formula bar | in cells F4 and Gé
in the formula bar ) 3 3/31/2013 A
4
5 |Last First Address Phone Date 'OVDs .F'ric'e per DVD Charge
135 College Ave. ] "
& |Feris Andrew Bar Harbor, ME 04609 (2075550101  3/5/2013] 2 su.wJ =F6°G6_|
1025 Droke Ave
J/ Garcia Susan Exeter, NH 03833 (603)555-1091 3/14/2013 25 $15.79

New Perspectives on Microsoft Office 2010
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Working with Formulas

* Copying and pasting formulas
— Cell references adjust to reflect new

location of the formula in the workshe__et

» " . . R RBATR A N A G — =3
o et Hagje Leyoust *nemiles Data Reoen w 2] o
™ 4 e AL A e W ¢ Cumngy = we | = Invert - !_; A -
e o B ZU-|G- N-A- EESAEE E $-% B T"v‘f j?l Ex i o ,nr ’)?
< @ - Formatting = w1 Toble - Gyles - [ZTomst = J= Faner - Select -
Cipboard 4 ront - 5 Ihgnment e Styte S| Editing
1 He - (® fo| =$87G3 I
A B c D : F G H S|
1 RipCity Digital
3 customer Orders | Shortcut button provides options | | formulas pasted cell containing
3 3/a1/2013 | for pasting formulas and values into selected range || copied formula
4
5 Last First Address Phone Date NVDs Pricg per DVD Charge
135 College Ave
6 |Ferris Andreyy Bar Horbor, ME 04609} (207)555-0101  3/5/2013 2 $17.29  $34.58
1025 Drake Ave.
7 |Garcia Susan Exeter, NH 03833 (603} 555-1091  3/14/2013 25 ! $394.75 } -
=i S North La,
8 [Torbet Dr. Lilla Oswego, NY13126  |{315)555-7823  3/17/2013 32
‘ 24 Mountain Dr.
9. |Rhoden Tony Auburn, ME 04210 (207}555-9915  3/24/2013 20
10 B (0T
11
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Working with Formulas

* Guidelines for writing effective formulas:
—Keep them simple
— Do not hide data values within formulas

— Break up formulas to show intermediate
results

New Perspectives on Microsoft Office 2010
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Introducing Functions

* Function
— Named operation that returns a value

— Simplifies a formula, reducing a long formula into
a compact statement; for example, to add values
in the range A1:A10:

* Enter the long formula:
=A1+A2+A3+A4+A5+A6+A7+A8+A9+A10
- Oor -
* Use the SUM function to accomplish the same
thing:
=SUM(A1:A10)

New Perspectives on Microsoft Office 2010
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Entering a Function

Ry - A A - ™ = 9 5 = B o K 71
it o | B2 B~ - A (E = AR B | o %o | 925 Covtonel Fomat | Cel | jag L | o St it |
Clphaard Font Alignmam Munbor tyter Leih Edting |
EFFECT v (" RV fo| SUM(FEFY -
| A B c — E=[W e
pCi gital
; sﬁ:v,,zf;;m a colored border indicates the
3 3/31/2013 range usedin the function
—
S |Last First Address Phone Date DVDs Price per DVD Charge
135 College Ave.
6 |Ferris Andrew Bar Harbor, ME 04609 {207} 555-0101 3/5/2013 2 $17.29 $34.58
1025 Droke Ave,
7/ | Garcia Susan Exeter, NH 03833 (603} 555-1091  3/14/2013 25 $15.79 5394.75 C
. 5 North Ln,
8 Torbet Dr, Lillo Oswego, NY 13126 {315)555-7823 3/17/2013 32 512.99 5415.68
24 Mountain Dr.
__9__ Rhoden Tony Auburn, ME 04210 {207} 555-9915  3/24/2013 20 $15.79 S315.80
S ScreenTip shows the function | T0™AL  [ZSUMIFS:rS
11 = : i { SUMEnumber L, [nurbeZ] ) |
5 being entered into the cell
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Entering Functions with AutoSum

* Fast, convenient way to enter commonly used
functions

* Includes buttons to quickly insert/generate:
— Sum of values in column or row (SUM)
— Average value in column or row (AVERAGE)

— Total count of numeric values in column or row
(COUNT)

— Minimum value in column or row (MIN)
— Maximum value in column or row (MAX)

New Perspectives on Microsoft Office 2010
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Entering Functions with AutoSum

e o | B2 - A | = A | s VoW ool eim o | e 1 & roax
_Qliphoare s root Allgnmam Muanber Ttyver Teily raning
_ EFFECT RV L SUMHSHS) [¥]
P4l B { C 0 | e S
; zz:::;"g:’;m Excel selects the range | | click to enter an Excel inserts the SUM
= el over whacl_\ the . {\utoSum function fynctlon and the most
; AutoSum is applied into the selected cell | | likely cell reference
5 Last First Address Phone Date DVDs Price per DVD Cﬁl:lin_gg__1
135 College Ave. $
6 |Ferris Andrew Bar Harbor, ME 04609 § {207} 555-0101  3/5/2013 2 $17.2 2
1025 Drake Ave. :
7 Garcia Susan Exeter, NH 03833 {603)555-1091  3/14/2013 25 $165. $394.75 f -
5 North Ln, g ?
8 Torbet Dr. Lilla Oswego, NY 13126 (315)555-7823  3/17/2013 32 $12.99)| $415.68
24 Mountain Dr. ;
4 |Rhoden Tony Auburn, MEO4210 (207} 555-9915  3/24/2013 20 $15.701| $315. ‘
10| TOTAL 79
11 SUMnumbeecl [number?] |
12 B
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Working with Worksheets

* |nserting a worksheet

—Name of new worksheet is based on
number and names of other sheets in the
workbook

* Deleting a worksheet
* Renaming a worksheet

— 31 characters maximum, including blank
spaces

—Width of sheet tab adjusts to length of
name

New Perspectives on Microsoft Office 2010
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Working with Worksheets

* Moving and copying a worksheet

—To move:
* Click and drag
—To copy:
* Ctrl + drag and drop

— Place most important worksheets at
beginning of workbook (leftmost sheet
tabs), less important worksheets toward
end (rightmost tabs)

New Perspectives on

Microsoft Office 2010
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Editing Worksheet Content

e Use Edit mode to edit cell contents

— Keyboard shortcuts apply only to text within
selected cell

value being edited 3
within the cell

{207) 55501 s S3458

{B03) 555

-

[ mode indicator
shows that Excel
L is in Edit mode

* Undoing and redoing an action

— Excel maintains a list of actions performed in a
workbook during current session
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Editing Worksheet Content

* Using find and replace

~

~, | Find and Resiace - - | |
(search string ) —
Find Replace 1
erlacement string) || Fodmiot  LAx o] [MoFometet | (oofometivas
- Repace Wil jAw:nue E [ ro Format set | [ Fommat.. ~ |~
limits the search | [T W& sneet  [x] I Motchose El’firfgﬁc?ﬁ?
tothecurrent | || search: [syrons  [] o e | the search
worksheet | ookin: [Formias  [3] [ Optiors << | string
L
! Y |
—I.raeo_hoeu | Reolsce AndAl | EndNext | Cose

T s

replaces all highlights all occurrences
occurrences (replaces the current occurrence) of the search string
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Editing Worksheet Content

* Using the spelling checker

Spelling: Englizh (U.5,)

| ¢ > h &
S ignores this

possible I Notin Dictionary:
misspelled —gizicit,
word |

i Supgrshons:

| \Rapecity

list of

| occurrence

[ meone = of the word

l
luuciomme “ ignoresaall
| ¢ toDictioney | r occurrences
A kof the word
[ ghee | }
[ crengem L " adds the word |

j to a personal

suggested i Dictionary lancusgs:  Erglsh (U.S)

alternate \ :
\ I Cphons...

spellings

i (& dictionary
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Previewing a Workbook

* Changing worksheet views
—Normal view
—Page Layout view
— Page Break Preview

New Perspectives on Microsoft Office 2010
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Page Layout View

YT NENI®ES

7]
L
L
)
A%
M v b

MpC iy Ogte

Cumra mse Ordur
¥oMIn
Lt Fsr Attwes
L S
Fora Ffovdees Aorvse
NSres

Geris - Suemas
YextrLare
Tonber Jc.nﬁp_""lllx
24 NouxvanDiee

Hvooin Tow Ahen ME NN

Rt
|S0T)EEE N

[00) 222 1131
[y a8
™Y

(207 T
w1

Docrnentaton | Customer Orglers 10

Neadty | Pagm1ofd |

Oiw
e

R
LU Bl B

LIS B S
TOraL

D05

P Oel Chane

s
s13 s
pizoe

e

worksheet will
span two pages

3k
14T
e

§Ehs
Anbuba

Chob o andd ha g

M

Page Layout
button

o

| RSO 6o,

s

New Perspectives on Microsoft Office 2010

41



Page Break Preview

sohcl blue line
surrounds section
to be printed

[ 4l A | B c 1 0 3 F G H
1 |RipCity Digital
2 |Customer Orders
] 3/31/2013
P i
5 |Last First Address Phone Date DVDs Price per DVD Charge
45 College Avenue
6 [Feris Andrew #2o, % (ztﬂsss—oml 3/5/2013 2' 5155.36 - $36.58
I 1024DA i |
7 |Garcia Susan Exeter, N 33 (603} 555-1091  3/14/2013 25 $15.79 $394.75
5 North Lane
_E |Torbet Dr. Lila |Oswego, NY 13126 {215)555-7823  3/17/2013 2 $12.99  $415.68
24 Mountain Deive |
9 |Rhoden Tony Auburn, ME 04210 (207}555-9915  3/24/2013 20, §15.79  $315.80
10 TOTAL $1,162.81
1
12

dotted lme indicates

__Customer Ordess

Documentation

Page Break
Preview button
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Previewing a Workbook

* Working with page orientation
— Portrait orientation (default)
* Page is taller than wide
—Landscape orientation
* Page is wider than tall
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Printing a Workbook

* Print tab provides options for choosing what
to print and how to print

— Printout includes only the data in the
worksheet

—Other elements (e.g., row/column headings,
gridlines) will not print by default

* Good practice: Review print preview before
printing to ensure that printout looks exactly
as you intended and avoid unnecessary
reprinting
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Printing a Workbook

z =
oeve _lv'm—-"t Page Lyyout Fommuler Dats L ew preView of printout
; e Primt Y
Sane As
click to print the = @ Do 1T =
. Wty Dt fusemer Tk
worksheet with the —— - Pt | i LA
N e
selected settings J 2 G P P ST
7 HP Universal Printing PS 1
. Recert H) 1oty
(select the printer ) - - 1
New Printer Pruperies
Settings
select What part i Prent Actvr Sheets S
of the workbook e ! oy et theacte s
to pﬁm J rPagcs s 1o s
H"V Sl Print on Beth Sides }‘_
S Fho pages on long edge v
1 Option:
£ o I'{lf}f j";mld 21 121 =
set the printer W ] Pestiak Crintacion .
options J 1=
L] g5 ~
Momal Margins =
U=t Left D7° Right: 0.7
click to scroll ] B e e sk
through the print S e
preview J

11 ofL ¥ JQ
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Viewing and Printing Worksheet
Formulas

e Switch to formula view

— Useful when you encounter unexpected results
and want to examine underlying formulas or to
discuss your formulas with a colleague

it In View
i_ *A AN = o ; 5 = Gene r.é_ ™ :""
e o | BT - D-A- === iEE H- s Condttions! Fom 4 rom
Clipk ! fo Lol
i B - f_- l;—lt |
D E ¥ G H S
: ( - ) :
3 | numeric date values | formulas are displayed
3 L 2re displayed ) rather than values
a
5 fPhone Date OvVDs Price per DVD Charge
g 4
6 |(207)555-0101 41338 2 18.29 _F6*G6
( text and numbers \‘
- remain unchanged | 7 |(603) 555-1001 41347 25 15.79 -F7*G7
\ / <
i (315) 555-7823 41350 32 12.99 =FE*G8
9 |(207) 555-9915 41357 ) 20 15.70 -F9*G9
10 TOTAL ~SUM(F6:FO) 8 | ~SUM{HE:HO)
1
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Viewing and Printing Worksheet
Formulas

* Scaling the printout of a worksheet forces
contents to fit on a single page

| "I 1 = = = 1 - N Gngy Heading: &y |
A [&lfon ) “ = E1) ' /‘ T hew
= LGl erre: = s ‘»'y- < e
) fe | Or, Lila o TR o &
Loty . .| printout width and height ]
- - set to a single page - '
[ g
| ki Hdi R i
text reduced to fit
the worksheet on
one page
~
zoom set to 50% )
T ""!:}r;!’;j!"" _ Gustomer Orders 95 [T+ : . ——— |
fleacy | Mopeieft | il O o (<) +)
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* Thank you
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